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What’s New in PowerScribe® 
360, Version 1.1

PowerScribe® 360, version 1.1, is the latest version of Nuance’s leading 
speech-recognition reporting solution for radiologists. This latest version 
gives you more control of your reports with the goal of making the 
dictation process faster and more accurate. PowerScribe 360 helps you 
achieve faster report turnaround time, reduce transcription costs, provide 
higher levels of satisfaction to referring providers, and enhance patient 
care.

Included in this version are enhancements to the peer review process, 
support for mobile devices, and several customer-suggested changes to 
the user interface, allowing providers to be even more productive when 
using PowerScribe 360.
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New Features

New Features For Providers
Many of the new features for providers are customer-suggested changes to the user interface. 
These new features, and others, are explained in greater detail in the remainder of this section.

• Log on with speech disabled

• Display addenda at the beginning of a report

• Display impressions by hovering mouse

• Improved temporary order workflow

• Automatic refresh in Explorer window

• Worklist display enhancements

• Browse display enhancements

• Enhanced secondary list sorting 

• Preliminary button for residents

• Additional status bar indicators

• Report note indicator enhancement

• Zoom in, zoom out on report text

• Toggle wet read on/off

• Improved viewing of AutoText in Report Editor

• Voice navigation for custom fields

• Automatically categorize AutoText

• Automatic Polling in AutoFeed 

• Custom fields alphabetized

• Tab to Merge Fields

• More specific software version information

• 2012 CPT and 2011 ICD-9 codes added to system
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Log on with Speech Disabled
A check box under the username and password fields on the log on window allows you to log 
on to the application without enabling speech recognition. 

Option to Display Addenda at Beginning of Previewed Reports
This new account preference allows you to display addenda at the beginning of previewed 
reports. Previewed reports appear at the bottom of the Explorer window and in the Prior 
Reports tab in the Report Editor window. 

View Report Impression for Previewed Reports
You can now quickly view a previewed report’s Impression section by hovering your mouse 
cursor over the report body. Previewed reports appear at the bottom of the Explorer window 
and on the Prior Reports tab of the Report Editor window.
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Improved Temporary Order Workflow 
When you enter an accession number not recognized by the system, a dialog box opens 
allowing you to select a site and enter or select a procedure code for the temporary order. 
Selecting a procedure code allows the relevant AutoText to be loaded.

Automatic Refresh of Explorer Results Window
Anytime one of the links in the My Reports section is selected and the number of items 
changes, the results window in Explorer is automatically updated with the new information.
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Worklist View Changes
The Worklist section of the Explorer window now appears in an expandable and collapsible 
tree view, making your worklists much easier to view and select.

Also note that the results list heading now shows which item you have selected as your 
search criteria. This information appears when you make a selection from either the My 
Reports section or the Worklists section. The above example shows that the Head and 
Neck CT worklist was selected.
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Browse Section Changes
Depending upon how your administrator has configured the PowerScribe 360 system, you 
might see a smaller subset of the browse filters (located in the Explorer window). The 
administrator can select which filters to show and which to hide. 

The two illustrations below show an example of the difference between seeing all filters and 
seeing a limited set of filters. (This setting affects both Client and Portal users.)

Secondary Sort in Results List
Each time you select a new column in the Results list, the previous column used for sorting 
is used as a secondary sort key. This feature applies to all list views in the application with 
the exception of the Explorer window, which has its own unique sorting methodology.

Preliminary Button for Residents
When a resident clicks the Preliminary button on the tool bar (or selects Send as 
Preliminary from the File menu), a draft version of a report is sent to the RIS without 
changing its status to Pending Signature. The report remains in the resident’s Draft queue.
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Additional Status Bar Indicators
The status bar (located at the bottom of each window in the application) now contains 
additional information, allowing you to quickly see the number of reports in your Draft queue 
and the number of reports in your Signing queue.

Report Note Indicator Enhancement
When you open a report containing new notes that were added since the report was last 
opened, the Notes button in Report Editor flashes three times to indicate new notes are 
available.
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Zoom Feature for Report Text
You can now right-click on report text and make a selection from then new Zoom menu to 
either increase or decrease the size of the text on your screen. This menu appears for all 
preview reports as well as the report you are currently dictating in Report Editor.

Changes to Wet Read Workflow
If your institution allows you to create wet read reports, you can now turn Wet Read on or off 
by using a menu item, keystroke, or toolbar button. The Wet Read On/Off toggle, available 
in the Explorer window only, allows you to create new reports with a Wet Read (Wet Read on) 
or Draft (Wet Read off) status.
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Improved Viewing of AutoText Items in Report Editor
The AutoText drop-down list in the Report Editor window has been replaced by a pop-up 
window which can display large result sets more clearly.

Voice Commands for Custom Fields
Several options and voice commands for custom fields are now available:

• You can dictate into the selected custom field.

• You can move among custom fields in your report using the “Next Field” and “Previous 
Field” voice commands.

• Navigating to the next field automatically transcribes the text in the previous field.

• For fields that contain more than one choice, the choices are displayed automatically. 

• The “Custom Field <custom field name>” voice command opens the Custom Fields 
dialog box and selects the existing custom field name you spoke in the voice command.

• For reports that contain more than one order, 

– the “Next Order” voice command selects the next item in the order drop-down, and
– the “Apply to all orders” voice command toggles the Apply to all orders check 

box.

Automatically Categorize AutoText
A new preference (Auto-categorize) now allows you to automatically include procedures in 
your AutoText. The choices for this preference are:

• Always - Procedures in the report’s order(s) are added to any AutoText that you insert.

• Prompt - You are prompted to accept categorization prior to the addition of any 
procedure(s).

• Disabled - Do not perform auto-categorization of AutoText.
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In addition, an Auto-categorize menu item is available when you right-click in the Report 
Editor’s AutoText tab area, allowing you to auto-categorize your personal AutoText. 

Automatic Polling in AutoFeed 
With AutoFeed enabled, PowerScribe 360 now automatically polls for reports when the 
AutoFeed queue is empty. When the polling begins, you will see a dialog box similar to the 
one below.

The Pause button allows you to suspend polling without having to return to the Explorer 
window. The Cancel button allows you to exit the AutoFeed mode and return to the Report 
Editor window. 

AutoFeed polling occurs every 30 seconds.

To enable AutoFeed polling:

1. Click Tools > Preferences.
2. Click Workflow and select the Enable AutoFeed polling check box.
3. Click OK.
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Custom Fields Alphabetized
The Custom Fields dialog box now lists all required fields first in alphabetical order, followed 
by the non-required fields, also listed in alphabetical order.

Tab to Merge Fields
You can now navigate between Merge fields in your reports using either the “Next Field” 
and “Previous Field” voice commands, or the Tab button on your microphone or keyboard. 
Previously, only Fill-In fields were selected when navigating or tabbing between fields. 

You can also overwrite the content of a merge field. Fields that are overwritten will not be re-
merged if updated information is received from the RIS

More Specific Software Version Information
The Help > About Nuance PowerScribe 360 menu item now displays the official product 
version and specific build information. For example, Nuance PowerScribe® 360 v1.1 
(build 4.0.xxxx).

Codes Added to System
The most recent CPT codes, version 2012, as well as the 2011 ICD-9 Codes are included in 
this version of PowerScribe 360. 
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New Features For Providers: Optional/Add-On
 

Peer Review Enhancements for Providers
The Peer Review feature contains several enhancements. 

Note: Some of the following items are controlled by your system administrator and might 
not apply to your institution. However, all of the new features are described below for 
your convenience.

• You can now use voice commands in the Peer Review dialog box:

• Your PowerScribe 360 system administrator can configure the system to allow you to 
finish dictating your current report before performing an automatic peer review.

• You can now add comments to the first two peer review rating levels. Comments for 
levels one and two are optional. Comments for levels three and four are still mandatory.

Voice Command Description

“Pick <1..4>” Selects one of the four available rating options

“Likely to be clinically 
significant”

Selects/clears the clinically significant check box (when 
it's active)

“<custom field name>” Selects one of the secondary fields: places the cursor in 
a text box; toggles a check box; or opens a drop-down 
list

“<drop-down item>” Selects the item you dictate from an open drop-down 
list

“Comments” Places the cursor in the Comments field, allowing you to 
dictate (or type) a comment

“Okay” Saves your peer review and closes the dialog box

“Close” Closes the dialog box without saving any changes to the 
peer review

• Peer Review enhancements

• Montage search capability

• Veriphy updates

• Applications for mobile devices
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• Your administrator can set a parameter to disable manual peer reviews, which would 
disable the Peer Review button in the Prior Reports windows in Explorer and Report 
Editor. If manual peer review is disabled, only automatic peer reviews will occur.

• The length of the descriptions of the peer review ratings (created by a system 
administrator) can now be up to 256 characters, allowing for more detailed descriptions.

• To help better define the reason for selecting a particular rating, you can create up to two 
custom secondary fields to provide additional input for peer reviews. Your system 
administrator can associate a secondary field with one of the primary ratings (in which 
case the secondary field appears directly below its assigned primary rating) or the 
secondary field can pertain to all of the primary ratings (in which case the secondary field 
appear below the list of primary ratings, as in the illustration below). 

These secondary fields can take the form of free text (Secondary Part 1 in the illustration 
below), a drop-down menu (Secondary Part 2 in the illustration below) from which you 
can make a selection, or, if only one choice is provided, a check box which you can select 
or clear. 
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Montage Search Capabilities
Montage provides enterprise search and performance analytics for radiology environments. 
In PowerScribe 360, you can use Montage to find information about the patient on whom you 
are currently dictating (Patient Record view, using the Montage tab in Report Editor, shown in 
the illustration below), or as a research tool to search for a specific word or phrase contained 
in any existing reports within your organization’s PowerScribe 360 system (results displayed 
in a separate window).

Refer to the Montage Quick Reference Card (L-3434-001) for details on how to use this tool. 

Veriphy Updates
• Document Only Workflow: You can now select Document Only from the Severity drop-

down list in the Critical Findings Message dialog box. Selecting Document Only means that 
Veriphy has documented the notification. An example message might look something like 
this: Message documented for <RecipientName> on <SendDate>. 

• Using Merge Fields: Veriphy messages can now be defined using merge fields, to include 
additional order or report information if desired

• Additional Message Audio: You now have the option to dictate additional audio if the 
report’s impression audio is included. Note that if the impression audio is unavailable or not 
included, you must dictate an audio message. 



15

What’s New in PowerScribe® 360, Version 1.1

G  Overview New Features Step-by-Step

F  For Providers G  For Providers

G  For Administrators

• Findings Levels: The Veriphy findings level (Severity) can now be included in the text 
statement that is inserted into the report when a message is passed successfully to Veriphy.

• Institutions with Multiple Locations: To provide the correct list of findings for your 
particular location, PowerScribe 360 passes your site/location information to Veriphy when 
you initiate a critical test result. Based on this site information, Veriphy returns the correct 
findings levels to PowerScribe 360, which then displays them in the Findings drop-down list 
in the Critical Findings Message dialog box.

Applications for Mobile Devices
PowerScribe 360 now has some of its key features available for mobile devices. The 
application is called PowerScribe 360 | Mobile Radiologist and is available for downloading 
from the iTunes App Store. For a closer look at these features, see PowerScribe 360 | Mobile 
Radiologist Application, beginning on page 25 in this document.

Assisted Diagnosis

Assisted Diagnosis is a tool that provides links to radiology topics based upon your report 
content. Highlight a word or phrase in your report and tap Assisted Diagnosis. From the list 
that appears, choose a search site to look for results. 

If you select Assisted Diagnosis from within a report, you will return to that same report 
when you close the Assisted Diagnosis window.

Sign Queue

The Sign Queue application allows you to select a report from your Drafts or Signing queue, 
review and edit the report, and then sign (for attending providers) or approve (for residents) 
the report.

Note: Currently, only text-based editing is available in the mobile application. 

Supported Devices

The following mobile devices, running either Apple’s iOS 4.3 or higher (including iOS 5.x) 
operating systems, are supported:

• iPad2

• iPad1 (original)

• iPhone 4S

• iPhone 4

• iPhone 3GS
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New Features for System Administrators

Remote Diagnostics
Remote Diagnostics services are now available, enabling Nuance Technical Support to be 
alerted to certain events, including:

• Service failure notifications (based on Windows Event Logs),

• Critical MS SQL events (based on Windows Event Logs), and 

• SUS server events.

Preference for Dragon’s Greedy Replacement Feature
Dragon’s greedy replacement feature replaces an entire word that has been only partially 
selected. For example, if a provider highlights only the letters im in superimposed 
infection, and then dictates “mild”, the resulting text would show mild infection. 

To control this feature, a preference called Enable Dragon greedy replacement (located in 
System > Preferences > Dictation tab) allows you to enable or disable this feature. By 
default this preference is enabled. (Only administrators can change this setting; end users 
cannot.)

• Remote diagnostics

• New preference for Dragon greedy replacement

• Browse and search filters can be hidden

• Updated Dashboard

• SQL Report Builder

• Preferences for mobile application users

• Printable reports in PDF format

• PACS integration improvements

• 2012 CPT and 2011 ICD-9 codes added to system

• More specific software version information
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Enable/Disable Browse and Search Filters 
The single account-level permission Allow Explorer search and browse has been replaced 
with two separate permissions (located on the Explorer Screen preferences tab): 

• Enable Explorer Quick Search: This check box determines whether the Quick Search 
section of the Explorer window is visible to providers. If not selected, the Quick Search 
section is hidden from the specified user. The initial value of this preference is inherited 
from the previous Allow Explorer search and browse preference setting. By default 
this preference is enabled. (Only administrators can access and change this setting.)

• Enable Explorer Browse: This drop-down box determines which sections of the 
Browse area in the Explorer window are visible to providers. You can choose:

– None: Hides the Browse section from the specified user
– Combination of one or more filters: Select individual filters to show to the user. 

Including one or more filters makes the Browse section visible to the specified user, 
showing only the filters you selected. In the illustration below, only five filters will be 
shown to users (Time Frame, Status, Site, Modality, and Anatomy).

– All: Shows the Browse section and all its filters to the specified user.

By default this preference is set to All. (Only administrators can change this setting.)
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Subscribed Worklist Preference
A new account-level preference (located in Setup > System > Preferences > Explorer 
Screen tab) called Show subscribed worklists only is now available. Select this check box 
to show users only worklists to which they are subscribed.

Updated Dashboard
The Dashboard (found in the Exams group), which shows User, Inbound, and Outbound 
system activity, has been updated. The three information groups are now tabs, and the 
Inbound and Outbound tabs contain new columns to provide expanded information about 
these events.

SQL Report Builder

Note: SQL Report Builder is an advanced Microsoft SQL Server feature designed for 
users who have experience with SQL Reporting Services, Crystal Reports Builder, 
or a similar database reporting tool.

SQL Report Builder (part of Microsoft SQL Server’s Reporting Services) is a client tool that 
lets you create, edit, view, and save report definitions based on information in the 
PowerScribe 360 Report Model.

Report designers use the report model as the data set for reports instead of directly 
accessing a relational database or OLAP cube data source when designing reports.

Settings for Mobile Application Users
For organizations who plan to use the new PowerScribe 360 | Mobile Radiologist application 
that’s available in version 1.1, two new preferences, Enable mobile access and Enable 
mobile reporting (located in Setup > System > Preferences > Permissions tab) are 
available.

In addition, enter your Mobile Client Identifier, located in the Setup > System.
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Printable Reports in PDF Format
A configuration option called Printable document format (located in Setup > System > 
Configuration > Web Portal tab) allows you to choose between the default PDF format 
and the native (binary) Microsoft Word DOC or DOCX formats when printing reports. The 
PDF is password protected so that editing the report is not allowed.

PACS Integration Improvements
Various improvements in PACS integrations were made in version 1.1. For more information, 
contact Nuance support.

Codes Added to System
The most recent CPT codes, version 2012, as well as the 2011 ICD-9 codes, are included in 
this version of PowerScribe 360.

More Specific Software Version Information
The PowerScribe 360 Admin Portal status bar (located at the bottom of the Admin Portal 
window) now displays the official product version information.
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New Features for System Administrators: Optional/Add-On

Peer Review Enhancements for System Administrators
Several new preferences and enhancements are now available for the Peer Review feature.

Launch Peer Review on Report Close Preference

This account-level preference controls whether a peer review is automatically initiated when 
a report is created, or prior to returning to the Explorer screen after creating a new report. 
The default value for the preference is False (check box not selected).

Exclude Inactive Accounts from Auto Peer Review Preference

This site-level preference allows you to exclude reports that were dictated or signed by 
inactive users.

Enable Manual Peer Review Preference

The new Enable Manual Peer Review account-level preference allows you to control 
whether users can manually initiate a peer review. If the preference check box is not 
selected, the Peer Review button on the Prior Reports tab (in both the Explorer and Report 
Editor windows) is disabled, allowing only system-initiated peer reviews. By default, this 
check box is not selected, meaning manual peer reviews are not allowed.

Information on How Each Peer Review was Initiated

A new column in the Exams > Peer Reviews section of the Admin Portal shows whether 
each peer review was system initiated or manually initiated. A new column in the Logs > 
Reports > Peer Review report in the Admin Portal also shows this information. 

Comments Allowed on Peer Review Ratings 1 and 2

You can now allow commenting on ratings levels 1 and 2. Ratings 3 and 4 are still mandatory. 

Length of Peer Review Ratings Description Increased

You can create peer review ratings descriptions up to 256 characters in length, allowing for 
more detailed descriptions. Previously the character limit was 100.

• New Peer Review enhancements

• eScription enhancements

• Montage search feature
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Custom Secondary Peer Review Ratings

A new drop-down list containing a list of secondary ratings is now available in the Peer 
Review dialog box. You can associate a secondary rating with one of the primary ratings (in 
which case the secondary rating appears directly below its assigned primary rating) or the 
secondary ratings can pertain to all of the primary ratings (in which case the secondary 
ratings appear below the list of primary ratings.
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Use the following table as a guide when creating custom secondary ratings in the Admin 
Portal:

In addition, a column in the Exams > Peer Reviews section of the Admin Portal shows this 
information. A column in the Logs > Reports > Peer Review report shows this information 
as well. 

eScription Enhancements
Administrators can now add an eScription ID (or speaker code) to user accounts. 

Note: The eScription ID is required in order for the integration to function.

Setting Description

Name Name that appears to identify the secondary rating

Description Name that appears as a tool tip when mouse is hovered over field

Rating Select a primary rating number (1 through 4)with which to associate the 
secondary rating; zero (default value) does not associate the secondary 
rating with a primary rating.

Display Order Allows you to choose the order in which the two secondary ratings are 
displayed; zero is first and one is second.

Choices Allows you to add either a single choice, which would appear as a check 
box; or multiple choices, which would appear as a drop-down list from 
which providers can choose. If you do not add a choice, the secondary 
field appears as a text box in which providers can enter text.

Active Select to have the secondary field appear in the Peer Review dialog box

Required Select to require a response or selection for the secondary field
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Montage Search
Montage provides enterprise search and performance analytics for radiology environments. 
In PowerScribe 360, you can use Montage to find information about the patient on whom you 
are currently dictating (Patient Record view, using the Montage tab in Report Editor), or as a 
research tool to search for a specific word or phrase contained in any existing reports within 
your organization’s PowerScribe 360 system (results displayed in a separate window).

Administrators must enter information into three fields in order to connect to the Montage 
system and make this tool available to providers. The fields are located in Setup > System 
> Configuration > Other Services tab. See the illustration below for examples. 
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Step-By-Step Instructions

Instructions for Providers

PowerScribe 360 | Mobile Radiologist Application 
The PowerScribe 360 |Mobile Radiologist application contains the following features:

• Assisted Diagnosis: Provides links to radiology topics based upon words or text you dictate, 
or highlighted report content.

• Sign Queue: Allows you to edit and sign reports that are in your Draft and Signing queues. 

Note: Sign Queue requires a valid login that includes a user name, password, and site 
name. Contact your PowerScribe 360 system administrator for these items if you do 
not already have them. 

• Settings: Allows you to configure the settings for the PowerScribe 360 mobile application.

Getting Started (Downloading and First-Time Use)

Downloading
The PowerScribe 360 |Mobile Radiologist application is available from the Apple iTunes App Store 
on your iPhone/iPad (or device to cover both types). If you are unfamiliar with downloading an 
application from the iTunes App Store, use the following steps as a guide.

1. On your device, tap the App Store icon.

2. Tap the Search icon (magnifying glass) at the bottom of the screen.
3. Tap in the search field at the top of the screen and begin typing nuance communications. 

Note: Nuance communications is a suggested keyword. Other search keywords include 
PowerScribe 360, radiologist, radiology, and diagnostic.

4. When the term nuance communications appears in the list, tap it. A list of Nuance 
applications available in the App Store appears.

5. Find and tap the PowerScribe 360 |Mobile Radiologist application.
6. On the Info screen, tap Free.
7. Tap Install App.
8. If requested, enter your Apple ID password and tap OK.
9. At the Download Now message, tap OK. 
10. After the application has installed, tap the Home button on your device. The PowerScribe 360 

|Mobile Radiologist application icon appears on your device’s screen.
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First-Time Use

1. Tap the PowerScribe 360 | Mobile Radiologist icon (shown at right). 
The first time you use the application you must accept the End User 
License Agreement.

2. At the End User License Agreement, tap Accept.
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Initial View
By default, the first screen that opens is the initial Assisted Diagnosis screen (shown below). 
At the bottom of the screen are tabs for the three features: Assisted Diagnosis; Sign Queue; 
and Settings.

Tap the feature you want to use. The rest of this section explains how to use these three 
features.
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Using the Sign Queue
Note: Sign Queue requires a valid login that includes a user name, password, and site name. 

Contact your PowerScribe 360 system administrator for these items if you do not already have 
them. 

Initial Login

1. Tap the PowerScribe 360 Radiologist icon.
2. Tap Sign Queue at the bottom of the screen.
3. At the login screen, enter your user name, password, and site name. 

Note: After your initial log in, the site name you entered is retained for your subsequent 
log ins, unless you change it.

First-time login Subsequent logins
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4. If you have access to multiple sites and want to select a different site, tap the arrow to the 
right of the site name to open the Site screen, and tap the site for which you want to sign 
reports.

5. Tap Login. The Sign Queue screen opens, displaying your most recent reports that require 
signature. From here you can also log out of the application and refresh your sign queue.

Multiple sites
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Viewing Report Details

1. To see pertinent report details, tap the blue pointer to the right of the report.

2. Tap the Sign Queue button in the upper-left corner to return to the sign queue list.

The icons to the left of the patient name (SQ and CQ in the above illustration) indicate the report’s 
status:

• SQ: Pending signature

• CQ: Corrected

• DQ: Draft queue
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Editing Reports
You can edit the text of your reports, if necessary, before signing them.

Guidelines for Report Editing

• Currently, you can perform only text-based editing, as opposed to voice or speech-
recognized editing. 

• When you edit a report in PowerScribe 360 | Mobile Radiologist, the report text is 
converted to plain ASCII text; any text formatting is removed.

• You cannot use PowerScribe 360 | Mobile Radiologist to edit reports that require custom 
fields, ICD-9 coding, or mammo coding.

1. Tap the report with which you want to work. The report opens, allowing you to view and scroll 
through it. 

2. Tap the report to bring up the keypad; double-tap a word to select it; or double-tap and slide 
to select consecutive words.

3. To highlight only the word you double tapped, tap Select. To select all the text in the report, 
tap Select All.

Double-tap endometrium
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4. Once the word is highlighted, another menu opens, showing several options. A set of icons 
opens at the bottom of the screen as well. 

Note: When the number of options is too large to display on a single bar, tap the pointer 
at the end of the bar to see the additional options.

• Cut, Copy, and Paste: Standard text editing options allow you to delete, copy, or paste 
another word over the highlighted word.

• Suggest: Offers alternate words for the selected word

• Define: Opens a screen with the word’s definition

• Assisted Diagnosis: Places the word in the Assisted Diagnosis search field and performs 
a search for the word.

5. You can edit and navigate within your report by using any of the following methods:

• Use the keypad. If text is already highlighted and you begin typing, the original text is 
replaced with the text you type. If no text is highlighted, tap the location in the document 
where you want to insert text and begin typing.

• To expand the amount of text you want to select, tap, hold, and drag one of the blue 
endpoints of the selected text and select the additional text.

• To cancel the highlighting and hide the bottom icons, tap Done, or just tap anywhere in 
the report.
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Signing and Saving Reports
After performing your edits, you can save your changes and/or sign (or approve, for residents) 
your report.

• Sign (or Approve) the report: Tap Sign (or Approve) to electronically sign your report. 
When the confirmation dialog box opens, tap Confirm to sign the report, and then tap OK 
at the Report signed successfully message. (You can also tap No to return to the report 
without signing it.) 

When you refresh your Sign Queue, notice that the report you signed is no longer in the list.

• Save your changes: Tap Save to save any changes you made to the report. When the 
Report saved successfully message opens, tap OK. The report remains in your Sign 
Queue list.

• Return to your Sign Queue: Tap Sign Queue in the upper-left portion of the screen to 
return to your Sign Queue list.
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Viewing Additional Report Information

1. Tap the report with which you want to work.
2. Tap the icon in the upper-right corner of the screen. The report info screen opens. 

Scroll through this screen to see detailed report information.

3. To return to the report itself, tap the icon in the upper-right corner or the report info 
screen. 

Tap to see report info Tap to return to report
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Using Assisted Diagnosis
You can use Assisted Diagnosis by dictating a word or phrase into the Assisted Diagnosis window, 
or by selecting a word or phrase in one of your reports.

To search from the main Assisted Diagnosis screen:

1. Tap the PowerScribe 360 icon on your device. By default, the Assisted Diagnosis window 
opens.

2. Tap the red record button. The toolbar at the bottom of the screen opens, showing the Dragon 
icon in red, indicating that speech recognition is active. 

3. Dictate the word or term you are seeking. (The example above shows that the words 
abdominal aorta were dictated.)

4. Use one of the following methods to initiate your search:

• Dictate “Stop listening”

• Tap the keyboard icon at the bottom of the screen, then tap Search

• After 30 seconds, the search initiates automatically

5. Once the search begins, your results appear. The first screen shown is the site of the main 
search provider that is configured in your settings. (See Configuring Your Settings, beginning 
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on page 38.)
The following illustration points out your options on the Assisted Diagnosis results screen.

Tap to hide bottom toolbar

Tap to clear text from search field

Tap to start/stop record

Slide to see additional
search sites

Tap to show/hide keypad

Tap to start/stop recordTap to see help for

Results area

and see main three icons

speech commands



37

What’s New in PowerScribe® 360, Version 1.1

G  Overview New Features Step-by-Step

G  For Providers F  For Providers

G  For Administrators

To use Assisted Diagnosis from one of your reports:

1. Tap Sign Queue and open the report that contains the text for which you want to search.
2. Select the word, or words from your report (using standard iPad/iPhone text editing taps).
3. Tap Assisted Diagnosis. Your default search provider opens, displaying the search results. 

4. From the results that appear, slide the list of web sites (at the top of the screen) and choose a 
site in which to look for further information on the topic. 

• If you selected text from one of your reports, you can return to that report by tapping Sign 
Queue again.

• If you entered text from the main Assisted Diagnosis screen, press the Home button on 
your device when finished.
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Configuring Your Settings
The Settings button allows you to configure your PowerScribe 360 mobile application.

1. Tap the PowerScribe 360 icon on your device. 
2. Tap the Settings button.

3. Use the following table as a guide for configuring your device.

Section Setting Description

Assisted Diagnosis Settings

Language Tap to select a display language. 
Default is English (United States).

Medical Language Model Tap to select a language model. 
Default is Radiology.

Search Provider Tap to select either Google, Bing, or 
Yahoo as your primary search tool. 
Default is Google.

Search Sites Lists the available search sites; 
current sites are MedPix; PubMed3; 
Chorus1; Yotta Look; Aunt Minnie; 
and Google Books

Remember First Tab When ON, the system remembers the 
last site you searched and uses it for 
your next search. Default is OFF.
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4. When finished changing your settings, tap Done in the upper-left corner of the screen to 
return to the screen on which you were previously working.

PowerScribe Settings

Auto Next When ON, after signing a report, 
automatically displays the next report 
for editing/signing. Default is OFF.

Auto Correction Turns off/on the Apple iOS auto 
correct feature for PowerScribe 360 
Mobile Radiologist only (not your 
entire device). Recommend turning 
OFF (the default setting) since the 
standard Apple iOS dictionary does 
not contain many of the medical 
terms used by providers. 

Auto Capitalization When ON, automatically begins new 
sentences with a capital letter.

Other

Build Version Shows the current software version of 
the mobile application

Restore Defaults Tap to return all settings to their 
default values

Section Setting Description


